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A Word About Nomenclature
Throughout this manual references are made to “BLADEs,” “sources,” “destinations,” 

and other terms whose meanings may not be instantly understood by everyone. Let’s take 
a moment to clarify some terms.

1. BLADE. In the WheatNet-IP system a “BLADE” is taken to mean an individual 
member of a WheatNet-IP system; any device that has a unique BLADE ID. It 
 commonly refers to an individual input/output rackmount unit, but a more complete 
definitionwouldincludeanynetworkconnectedPCrunningaWheatNet‑IPdriver
aswell,includingAutomationserversandeventheProgramDirector’sPCifthey
arerunningtheWheatNet‑IPdrivertolistentoaudiostreams.Conversely,anyPC
that is running the WheatNet-IP Navigator GUI program or using a browser for in-
terfacing to the built in web servers on BLADEs is not a BLADE itself. Only those 
devices that can transmit and/or receive WheatNet-IP audio streams are “BLADEs.”

2. Source. A source is any audio signal in the WheatNet-IP system that is uniquely 
generated. Any WheatNet-IP signal that is created by accepting and packetizing an 
input is a source, as is any signal generated within the system. Source signals may 
be audio, logic, or both. A logic source might be a logic port triggered by an external 
switch. We generally avoid using the term “input” to describe WheatNet-IP signals 
because the term can be misleading. One would easily understand that an external 
audio input jack could be an “input” or “source,” but less obvious is the fact that 
an audio mix bus output is also a WheatNet-IP source because it is generating a 
unique signal (the mix) and making it available to stream throughout the system. 
Likewise,PCsstreamingaudiofromafileviatheWheatNet‑IPdrivercanclearly
be seen as a “source.”

3. Destination. A destination is the opposite of a source. It is a signal that can accept 
any WheatNet-IP stream. A destination can take the received WheatNet-IP stream 
andconvertittoaphysicalanalogordigitaloutput,or,inthecaseofaPC,avirtual
outputthatsubsequentPCapplicationprogramscanconverttoanaudiooutputat
thePC’sspeakers,orlaydownasanaudiotrackontheharddisc.Destinationscan
be audio, logic, or both. A logic destination might be a logic port wired to a lamp 
or relay. We avoid using the term “output” for WheatNet-IP signals. While it is 
clear that a WheatNet-IP destination wired to an output jack is an “output,” control 
surface fader channels would not normally be considered “outputs” but they are 
“destinations” in the WheatNet-IP system, because you can route a WheatNet-IP 
audio stream to them.

4. LIO. Shorthand for Logic Input or Output. In the WheatNet-IP system, an LIO 
signal is a signal that either generates or receives logic state information created 
either physically via a logic port or virtually via some state change within a mixing 
control surface. In the WheatNet-IP system logic information can be routed and 
cross connected just as audio can be.

5. GUI. Shorthand for Graphical User Interface. A method of providing for user inter-
action with the system using a special computer program that displays information 
in the form of images and text on the computer screen and accepts user input via 
typing and mouse clicking within the computer program. The WheatNet-IP Naviga-
tor is a computer program that provides a GUI.
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General Information
Introduction

The Network Edge was created to support use of low cost IP radios for WheatNet‑IP 
audio links. So why are some IP radios cheap and others very expensive? A full duplex 
radio used historically for STL links has the ability to transmit data simultaneously in both 
directions.Doingsorequiresthatthereceiveamplifiermusthaveverysignificantrejection
ofthetransmitterRF,andthataddscost.HalfduplexIPradioswhicharesignificantlylower
cost,  handshake between the two ends to decide when each will burst transmit  data while 
the other must be in receive mode. This half duplex mechanism requires more complex 
control,butsignificantlyreducestheRFTX/RXfrontendcost.

The half duplex scheme however creates a problem for the WheatNet‑IP  system that is 
based on the use of high speed Ethernet switches for moving small Ethernet packets with 
minimal latency thru the network fabric. The BLADEs ingest the small .25msec packets 
and only buffer a few of them before playing out the audio thereby limiting latency to less 
than 1 msec. For real time production,  the latency for mix‑minus feeds is critical to keep at 
a minimum. The half duplexing rate of IP radios is on the order of several milliseconds. The 
control scheme of radios will ingest and store many packets during one phase of  duplexing. 
Subsequently, this data is bursts across the link at a much higher rate and it buffered up on 
theRXsideoflink.ThatdataisthenspurtoutaspacketsontotheEthernetnetworkonfar
side. The same operation is done from far side to near side but during opposite phase of 
duplexing. The point here is that the IP radio creates an unpredictable dynamic latency to 
packetsflowingacrossthelink.
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The EDGE alleviates this random latency problem by adding a buffering mechanism 
 between the radio and the network. The EDGE can be located at either end of the link, 
but the way it operates with WheatNet‑IP  depends which end it is located on. For both 
cases, the internal hardware of EDGE remains mostly the same. Small .25 msec packets are 
ingested,bufferedandrepackagedas5msecpackets.Thereare4instancesofthisRX-TX
mechanism which we have denoted as BIG for signal name defaults. 
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EDGE Installation Options
The EDGE may be installed at either the Studio or Transmitter sides of the IP‑STL link. 

Where you decide to install it depends on a few factors:
• IP Radio quality
• BLADE infrastructure
• Cost.

EDGE Installed on the Studio Side

For a “Studio‑Edge” IP‑STL application, the EDGE connects to the WheatNet‑IP Ethernet 
network located at the studio end of link and a BLADE is then located at the transmitter 
(TX)end.TheTXsideBLADEconnectstoanotherEthernetswitchalongwiththeIPRadio.

In this case, PGM audio from a control room needs to get through an IP radio to the 
 transmitter site. In Navigator, the desired PGM mix Source is routed to one of the four 
EDGE Buffers. EDGE Buffer inputs automatically appear as Destinations in the Naviga‑
tormatrixwhentheEDGEisfirstconfigured.Likewise,theEDGE’spost-delay,Buffered
outputs automatically appear as Sources in the Navigator matrix. 
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Next, the corresponding Buffer Source is routed to a physical audio output Destination 
on the Transmitter end BLADE located at the far end of IP radio link. Individual DELAY 
controlsforeachofthefourEDGEBufferoutputsallowtheusertofinetunetheplayback
bufferdepth,thuscompensatingforlatencyintheIPradio’sstream.

Because the small WheatNet‑IP packets have been buffered by the EDGE prior to IP 
radio transmission, Ethernet overhead is reduced and the IP radio BW requirements are 
somewhat relaxed.

Managed Gigabit 
Ethernet Switch

Surface (Console)

Small Packets

Delayed  
PGM

Air PGM to 
Buffer

Return  
Audio 

Return Audio 
to Buffer

AES or  
Analog Audio

Air PGM
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2.5MB/sec per stream
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EDGE

to Airchain

STUDIO TRANSMITTER

Delayed
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EDGE At Studio
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Ethernet Switch

EDGE Installed at the Transmitter Side

Fora“TX-Edge” IP-STLapplication,an IP radio isconnected to theWheatNet-IP
EthernetnetworkontheStudiosideandtheEDGEisthenlocatedatthetransmitter(TX)
end. The EDGE connects to another Ethernet switch along with the IP radio. A BLADE, 
co‑located at the transmitter site is not required, but can provide valuable resources and 
functionality(silencedetection,mixing,audioclipplayer,etc.).

In this case, PGM audio from a control room still needs to get through an IP radio to the 
transmitter site. In Navigator, the desired PGM mix Source would be routed to one of the 
EDGE’stwoanalogortwoAESDestinations feeding the rest of the air chain.  Individual 
DELAYcontrolsforeachoftheanalogandAESoutputsallowtheusertofinetunethe
playback buffer depth, thus compensating for latency in the IP‑radio stream.
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EDGE Delay Controls

The EDGE DELAY interval is adjustable to accommodate various parameters of 
the IP radio link. A minimum number of samples is required to overcome the duplexing 
interval of the link. The control setting of upwards of one second is more for testing and 
confirmation that the appropriate connections and data paths have been chosen. All eight 
EDGE Destinations, four BUFFERS, plus two analog outputs, and two AES outputs 
feature a DELAY control that may be adjusted using the EDGE GUI.

Return Path Audio

In both cases, installation of an Edge at the Studio or Transmitter site, there are means 
to bring a return audio feed from the Transmitter back to the Studio.  

In the “Studio EDGE” case where a BLADE exists at the Transmitter, the desired Return 
audio Source is wired to audio inputs of the TX site BLADE which appear in Navigator 
as a standard BLADE Source stream. This .25mS packet Source stream is then routed to 
an EDGE BUFFER destination. The BUFFER in turn feeds a variable DELAY whose 
output appears as a Source in Navigator. That buffered source can now be connected to 
any BLADE in the system where the audio will again be buffered and played out with 
additional delay. The latency of the audio in this return path will be 100 msec or more.  
The BLADE buffers 5 msec packets upwards of 100 msec, and then the DELAY setting 
of the EDGE would be in addition to that. 

In the “TX EDGE” case, return audio would simply be connected into the EDGE 
inputs, Analog or AES,  and those sources would be available to any BLADE back in 
the Studio with the corresponding latency. Note that these physical audio inputs are only 
available as 5msec packets. 

Analog and Digital Audio I/O Connections

The EDGE provides two stereo analog inputs and two stereo analog outputs on XLR 
connectors. A pair of AES inputs and a pair of AES outputs are also available on RJ-45 
connectors. These inputs are fed through a fixed 100mS buffer and available in  Navigator 
as Sources.

In a Studio EDGE installation, the analog and AES I/O may not be required.
In a Transmitter EDGE installation, Analog or AES outputs would be utilized to feed 

an air chain, while the analog or AES inputs may be used for return path audio.

Synchronization – PLL Settings

The EDGE and BLADE both use Ethernet packets for sample rate clock  synchronization.  
The IP radio inherently adds a substantial jitter to these timing reference packets. 
In order to overcome the jitter, the error integration interval and overall loop locking must 
be extended significantly. A PLL MODE selection is provided to accommodate for this.

Studio EDGE Model: 
• The EDGE “PLL MODE” is set for LOCAL.  
• The TX side BLADE set to SLOW PLL mode for that unit only.



page 1 - 6EDGE Network / Jan 2016

G E N E R A L  I N F O R M A T I O N

• Transmitter EDGE Model
• EDGEPLLMODEissettoREMOTE.

Routing Rules

The EDGE was designed as a versatile buffer interface which leverages the core 
strengthsoftheWheatNet-IPandNavigatorroutingmatrix.WhileallEDGEI/Obuffers
and hardware interfaces appear as signals in Navigator, not all available routing path 
 combinations are valid. The following rules apply when routing EDGE signals in Navigator:

• Route any surface mix or physical Blade input to any EDGE Destination.
• Buffer Source signals may not be routed to other Buffer Destinations. 
• EDGE physical inputs may not be directly routed to any Buffer Destination.
• WheatNet‑IP PC Driver signals may not be directly routed to any Buffer Destination.
• Use Utility Mixers to create a low latency mix of buffered streams, and route the 

Utility Mixer output as required to any EDGE Destination.
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Rack Mounting
The EDGE is designed to be mounted in an industry standard 19" equipment rack, and 

requires one rack unit (1.75 inches) of vertical space. The EDGE has a depth of 9-1/2" 
behind the rack rails (including chassis connectors). An additional five inches of space 
is required for wiring cables to pass through. The chassis has a width of 17-3/8". Space 
needed in front of the rack rails is 3/4".    

The EDGE has vertical slots positioned in the side panels for venting. Make sure your 
installation does not obstruct these slots. There is no fan inside the EDGE because its 
power consumption is low enough to not require one.

The EDGE may be mounted between other devices in the equipment rack and in 
 accordance with good engineering practice should not be mounted directly above  devices 
that generate significant amounts of heat. If such a location is unavoidable then it is   to 
utilize an extra 1RU blank rack panel between the WheatNet‑IP and devices immediately 
above and/or below it.

WARNING! Under no circumstances should the EDGE unit be opened! The unit 
contains high voltage circuits that are hazardous and potentially harmful. The unit 
has no user-serviceable parts inside! If you have a problem the unit must be returned 
to Wheatstone Corporation for repair. 

Installation Tips
• Place any surge protection circuits as close as possible to the EDGE or other device 

being protected. 
• Establish a low impedance common ground in your facility and try to route all grounds 

to that point.
• Choose the best power conditioning / UPS units that you can afford and suitable for 

your equipment – focus on the features and options you need. The better UPS  products 
can prevent thousands of dollars in equipment damage – some even come with an 
external equipment damage warranty.

Energizing
Once it has been installed in the rack, the EDGE may be energized by connecting the 

factory supplied power cord to a source of AC power. The AC line input voltage is  permitted 
to be between 90 and 260VAC, 50 or 60Hz. Power consumption is under 100VA. 

Aggressive AC input filtering is utilized at the AC input of the EDGE; however, it is 
always advisable to use external surge protection and/or an uninterruptible power supply 
(UPS), especially where AC power quality is questionable, such as at a remote transmit‑
ter site. 

Power conditioning, surge suppression, and even power backup devices are wise 
 investments when using sensitive modern electronic devices that use an internal computer. 

Use of a UPS (uninterruptible power supply) is a good idea and will protect the EDGE 
from short duration power interruptions which may cause it to reboot. 
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EDGE Hardware Features 

 The front panel of the EGDE houses 8-segment, multi-color LEDs for metering four 
pairs of streaming audio and input or output signals. The front panel also sports an OLED 
display which can show various status messages relating to the EDGE’s performance and 
configuration. The front panel display, button, and knob quickly and easily allow you 
to set up and configure each EDGE. Pressing the button takes you to the main menu, or 
backs out to the previous display. Rotation of the knob  navigates up and down a menu 
when there is a list, or scrolls through options in a submenu once one has been selected. 
Pushing the knob “takes” an option. Use of the controls will become clearer as we go 
through some examples.

A headphone jack on left side complete the front panel. 

The rear panel has four female XLR connectors for analog inputs and four male 
XLR connectors for analog outputs. It also has four RJ-45 (A1 IN, A2 IN, A1 OUT, and  
A2 OUT) connectors for analog input and output connections so you can choose your 
preferred connector type. 

Four RJ‑45 (D3 IN, D4 IN, D3 OUT, and D4 OUT) connectors are for digital input 
and output connections. 

Two RJ‑45 connectors provide 12 logic ports, which can be individually designated 
during set up as inputs or outputs. Use these ports to wire the various external switches, 
indicators, and control functions you need in your facility.

There is an RJ‑45 connector for 100 Megabit Ethernet connection to the WheatNet‑IP 
network.

Consult the wiring diagram on page 1‑11 for detailed information.
At the far right of the rear panel is a standard IFC power connector. The EDGE has 

an internal power supply that will accept 100-240 Volts 50/60 Hertz AC power.

Network Switches
The next component of the WheatNet‑IP system is your network switch(es). These 

are standard Ethernet devices that form the core of your LAN. You may already have 
a suitable one in place in your facility. There are literally hundreds of different models 
available in the market place which vary widely in size and capability, costing anywhere 
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from $30 to $30,000 and up. Obviously the $30,000 switch has more features and  capability 
than the $30 switch. The important thing to remember is that most Gigabit switches will 
work with WheatNet-IP – up to a point. As the size of your system increases, it’s easy to 
exceed the capability of inexpensive switches. Large systems need high capacity managed 
switches to avoid the bane of Ethernet audio systems, network overload. Simply put, if the 
WheatNet‑IP devices are streaming packets faster than the Ethernet switch can distribute 
them, packets get dropped and the audio starts to break up. This is why your Ethernet 
switches must be sized appropriately, and your network traffic managed and controlled so 
that the sizing assumptions you made remain valid. Because 24 bit 48K sample rate audio 
streams represent a much larger packet rate than Ethernet networks were originally  assumed 
to contain, they can represent the vast majority of data in the network. Consequently just 
about any switch or link can get overloaded if you are streaming lots of channels and 
don’t attempt to manage your network and switch configuration. Conversely, because we 
use Gigabit ports for the WheatNet‑IP to minimize link overload issues, a smaller system 
will run just fine on an inexpensive unmanaged switch, as long as it is a Gigabit switch. 
It’s all in the numbers.

It is important that the Ethernet network be properly set up in order for the EDGE to 
successfully join in with the rest of the WheatNet-IP system. 

CAT6 Wiring
The next component of your WheatNet‑IP system is the CAT6 wiring itself. Each 

EDGE requires a single 100 Megabit network connection, which is typically a CAT6 
cable. Due to the nature of Ethernet and CAT6 cabling, these connections must be at least 
1 meter but less than 100 meters in length. If you must connect devices together that are 
more than 100 meters apart, use an interim Ethernet “edge” switch, or else use optical 
fiber and copper/fiber convertors to extend the range of the Ethernet LAN connections.

Software Tools
The next components of your WheatNet‑IP system are the software tools used to 

 administer it. While the WheatNet‑IP system is completely functional (unlike some 
 competitors) without running any software on a PC, you will find the Navigator GUI 
 program very handy for administrating normal system functions like setting access 
 passwords, controlling signal visibilities, naming sources and destinations, etc. The EDGE 
also employs the Wheatnet Edge Setup GUI for configuration which described later in 
this manual.
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I/O Connections

Audio Inputs

The EDGE accepts three types of audio input sources:
• Balanced analog line level left/right audio;
• Digital AES3 compliant left/right audio with sample rate of 44.1kHz or 48kHz;
• WheatNet-IP via 100BaseT Ethernet connection to a WheatNet-IP audio network.

The EDGE is fed from a combination of analog inputs via four XLR or two  
RJ 45 connectors and digital inputs via two RJ‑45 connectors.

The digital inputs of the EDGE will be sample rate converted to the system’s chosen 
sample rate of 44.1kHz or 48kHz, which is set via the WheatNet-IP Navigator GUI.

Analog – XLR

XLR 1L Pin 1 – SH
XLR 1L Pin 2 – HI      Input 1 Lt  
XLR 1L Pin 3 – LO
XLR 1R Pin 1 – SH
XLR 1R Pin 2 – HI      Input 1 Rt 
XLR 1R Pin 3 – LO
XLR 2L Pin 1 – SH
XLR 2L Pin 2 – HI      Input 2 Lt 
XLR 2L Pin 3 – LO
XLR 2R Pin 1 – SH
XLR 2R Pin 2 – HI      Input 2 Rt 
XLR 2R Pin 3 – LO

Analog – RJ-45

RJ‑45 A1 Pin 1 – HI
RJ‑45 A1 Pin 2 – LO
RJ‑45 A1 Pin 3 – HI
RJ‑45 A1 Pin 6 – LO
RJ‑45 A2 Pin 1 – HI
RJ‑45 A2 Pin 2 – LO
RJ‑45 A2 Pin 3 – HI
RJ‑45 A2 Pin 6 – LO

Digital – RJ-45

RJ‑45 D3 Pin 1 – HI
RJ‑45 D3 Pin 2 – LO
RJ‑45 D4 Pin 1 – HI
RJ‑45 D4 Pin 2 – LO

Input 1 Lt

Input 1 Rt

Input 2 Lt 

Input 2 Rt 

Input (AES) 3

Input (AES) 4 



page 1 - 11EDGE Network / Jan 2016

G E N E R A L  I N F O R M A T I O N

Audio Outputs

The output signals are available as analog line level (+4dBu, balanced) on the four XLR 
connectors, or on the two RJ‑45 connectors and as digital on the two RJ‑45 connectors. 
Analog – XLR

XLR 1L Pin 1 – SH
XLR 1L Pin 2 – HI      Output 1 Lt 
XLR 1L Pin 3 – LO
XLR 1R Pin 1 – SH
XLR 1R Pin 2 – HI      Output 1 Rt
XLR 1R Pin 3 – LO
XLR 2L Pin 1 – SH
XLR 2L Pin 2 – HI      Output 2 Lt
XLR 2L Pin 3 – LO
XLR 2R Pin 1 – SH
XLR 2R Pin 2 – HI      Output 2 Rt
XLR 2R Pin 3 – LO

Analog – RJ-45

RJ‑45 A1 Pin 1 – HI
RJ‑45 A1 Pin 2 – LO
RJ‑45 A1 Pin 3 – HI
RJ‑45 A1 Pin 6 – LO
RJ‑45 A2 Pin 1 – HI
RJ‑45 A2 Pin 2 – LO
RJ‑45 A2 Pin 3 – HI
RJ‑45 A2 Pin 6 – LO

Digital – RJ-45

RJ‑45 D3 Pin 1 – HI
RJ‑45 D3 Pin 2 – LO
RJ‑45 D4 Pin 1 – HI
RJ‑45 D4 Pin 2 – LO

Logic Ports

The EDGE has two LOGIC 1‑6 and 7‑12 RJ‑45 connectors that provide 12 Universal 
logic ports.

LOGIC 1 - 6 - RJ-45

RJ‑45 Pin 1 – Digital Ground
RJ-45 Pin 2 – Logic 1 In/Out
RJ-45 Pin 3 – Logic 2 In/Out
RJ-45 Pin 4 – Logic 3 In/Out
RJ-45 Pin 5 – Logic 4 In/Out
RJ-45 Pin 6 – Logic 5 In/Out
RJ-45 Pin 7 – Logic 6 In/Out
RJ-45 Pin 8 – +5V Digital

Output 1 Lt

Output 1 Rt

Output 2 Lt

Output 2 Rt

Output (AES) 3

Output (AES) 4
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LOGIC 7 - 12 -  RJ-45

RJ‑45 Pin 1 – Digital Ground
RJ-45 Pin 2 – Logic 7 In/Out
RJ-45 Pin 3 – Logic 8 In/Out
RJ-45 Pin 4 – Logic 9 In/Out
RJ-45 Pin 5 – Logic 10 In/Out
RJ-45 Pin 6 – Logic 11 In/Out
RJ-45 Pin 7 – Logic 12 In/Out
RJ-45 Pin 8 – +5V Digital

Network Connection

The EDGE can connect to a network or PC/laptop over Wired Ethernet via the 
100Base‑T Ethernet port on the rear panel. This port is completely independent and  
Auto-MDIX, allowing it to support straight-through and crossover cables in any 
 combination. The wired Ethernet interface can support up to four simultaneous  connections 
to remote  GUIs.

For typical CAT6 cable pinouts see below. These connections are for  communicating 
with the configuration computer via a network.

Ethernet – RJ-45

Pin 1 – TXD +
Pin 2 – TXD -
Pin 3 – RXD +
Pin 4 – N/C
Pin 5 – N/C
Pin 6 – RXD -
Pin 7 – N/C
Pin 8 – N/C

                              Typical Straight -Through Cable

1

2

3

4

TXD +

TXD -

RXD +

RXD -

PIN

1

2

3

4

PIN

RJ-45
Plug RJ-45

Plug

White/Orange

5

6

7

8

N/C

N/C

5

6

7

8

Orange

White/Green

Blue

White/Blue

Green

White/Brown

Brown

N/C

N/C

White/Orange

Orange

White/Green

Blue

White/Blue

Green

White/Brown

Brown
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                                    Typical Crossover Cable

1

2

3

4

TXD +

TXD -

RXD +

RXD -

PIN

1

2

3

4

PIN

RJ-45
Plug RJ-45

Plug

White/Orange

5

6

7

8

N/C

N/C

5

6

7

8

Orange

White/Green

Blue

White/Blue

Green

White/Brown

Brown

White/Green

Green

White/Orange

Blue

White/Blue

Orange

White/Brown

Brown

N/C

N/C

RXD +

RXD -

TXD +

TXD -

N/C

N/C

N/C

N/C



2 1
3

ANALOG INPUTS

1L XLR-F

PIN 1 - INPUT 1 LT SH
PIN 2 - INPUT 1 LT HI
PIN 3 - INPUT 1 LT LO

2 1
3

1L XLR-M

2 1
3

PIN 1 - INPUT 1 RT SH
PIN 2 - INPUT 1 RT HI
PIN 3 - INPUT 1RT LO

2 1
3

2 1
3

PIN 1 - INPUT 2 LT SH
PIN 2 - INPUT 2 LT HI
PIN 3 - INPUT 2 LT LO

2 1
3

2 1
3

PIN 1 - INPUT 2 RT SH
PIN 2 - INPUT 2 RT HI
PIN 3 - INPUT 2 RT LO

2 1
3

1R XLR-F 1R XLR-M

2L XLR-F 2L XLR-M

2R XLR-F 2R XLR-M
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ANALOG OUTPUTS

PIN 1 - OUTPUT 1 LT SH
PIN 2 - OUTPUT 1 LT HI
PIN 3 - OUTPUT 1 LT LO

PIN 1 - OUTPUT 1 RT SH
PIN 2 - OUTPUT 1 RT HI
PIN 3 - OUTPUT 1 RT LO

PIN 1 - OUTPUT 2 LT SH
PIN 2 - OUTPUT 2 LT HI
PIN 3 - OUTPUT 2 LT LO

PIN 1 - OUTPUT 2 RT SH
PIN 2 - OUTPUT 2 RT HI
PIN 3 - OUTPUT 2 RT LO

1
2
3
4
5
6
7
8

INPUT 1 HI
INPUT 1 LO

A1 RJ-45

1
2
3
4
5
6
7
8

INPUT 3 (AES) HI
INPUT 3 (AES) LO

D3 RJ-45

1
2
3
4
5
6
7
8

INPUT 2 HI
INPUT 2 LO

A2 RJ-45

1
2
3
4
5
6
7
8

D4 RJ-45

INPUT 4 (AES) HI
INPUT 4 (AES) LO

ANALOG/DIGITAL INPUTS

1
2
3
4
5
6
7
8

OUTPUT 1 HI
OUTPUT 1 LO

A1 RJ-45

1
2
3
4
5
6
7
8

OUTPUT 3 (AES) HI
OUTPUT 3 (AES) LO

D3 RJ-45

1
2
3
4
5
6
7
8

OUTPUT 2 HI
OUTPUT 2 LO

A2 RJ-45

1
2
3
4
5
6
7
8

D4 RJ-45

OUTPUT 4 (AES) HI
OUTPUT 4 (AES) LO

ANALOG/DIGITAL OUTPUTS

1
2
3
4
5
6
7
8

TXD +
TXD -

RJ-45

ETH

RXD +

RXD -

1
2
3
4
5
6
7
8

DIGITAL GROUND
LOGIC 1 IN/OUT

1 - 6 RJ-45

1
2
3
4
5
6
7
8

7 - 12 RJ-45

LOGIC

LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL
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EDGE Front Panel Operation

Adding EDGE to the Peripheral Devices Tab
In order to utilize all the features of the EDGE in a WheatNet‑IP system the device 

must be added to the System 3rd Party Devices tab in the Wheatstone WheatNet‑IP 
Navigator program (aka the  Navigator GUI).  Below is the basics of that procedure. Refer 
to the WheatNet‑IP Audio Over IP  Network Technical Manual for additional details.

You will need to know the IP address of the EDGE being added, so you will want 
to find that out or set it as desired before you start. See the section below on the EDGE 
Menu for details on checking and setting the IP address.

Launch the Navigator GUI and make sure that System 0 is selected in the System pane. 

Now, to the right of the System pane, select the Peripheral Devices tab.
Click the Add button on the far right to bring up the Add Peripheral Device dialog 

shown on right:
Type in a convenient Name and insert the IP  Address of 

the EDGE being added. Leave the TCP Port at the  default 
setting of 60021. From the Host Blade drop down select 
the BLADE that you want to associate the Peripheral 
device with. Click Ok.

This completes the process of adding the device to the 
Peripheral Devices tab. The added device should show 
up in the System pane under the BLADE you added it to. 

If it does not show up, or if it shows up but has a yellow 
question mark on it, then there is either a network issue 
that needs attention, or the device is not connected to the 
network at all, or one or more steps have been omitted or 
done incorrectly in the  configuration process.
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The System Crosspoint screen will now include the EDGE’s connections.

Front Panel Controls

There are two front panel controls that you will use whenever you need to do any con‑
figuring or testing from the front panel.

The knob serves a dual purpose. It is used to scroll through menu selections and pa‑
rameter choices, by rotating the knob, and it is used to advance through parameter fields, 
by pressing and releasing the knob.

The other control is the square BACK button. You can’t rotate this, so we will only 
tell you to press it. When we say this we also imply that, once pressed, you will release it.
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OLED Display
Once EDGE has joined the system its front panel OLED display 

will show several pieces of  information:
•	 Source	Name – The topmost line shows the name of the cur‑

rent source.
•	 Destination	Name – The location of the current source is shown 

below the source name.
•	 BLADE	Name – The 3rd line displays the name of the current 

BLADE that the EDGE is associated with.
• On the left of the bottom line RJ‑45 connector icon will show green and have 

moving dots next to it if the EDGE is connected to the network. If it is not con‑
nected the RJ‑45 icon will show red and there will be no dots.  
In the center of the bottom line In or Out indicates whether the EDGE’s signal 
meters are displaying input or output. 
The WNIP on the right side of the bottom line will show green if the EDGE is 
connected to the Wheatnet‑IP system.

EDGE Front Panel Configuration

Activating any of the front panel controls will replace the screen saver display with 
the information screen.

Press the BACK button to open up the main menu screen: 

Pressing the BACK button again will take you back to the information screen. 
Rotation of the knob  navigates up and down a menu when there is a list, or scrolls 

through options in a submenu once one has been selected. Pushing the knob “takes” an 
option.
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To edit any parameter or name, press the knob to highlight the parameter. Turn the knob 
to find the desired value or character, then press the knob to take it. If the parameter has more 
than one field you can scroll the knob to cycle through the fields.   

The BACK button backs out of a submenu to the main menu. 
For example, when you 

select Headphone... by press‑
ing the knob the Headphone 
display with Source and Gain 
shows in the window.

To choose a source, push 
the knob to highlight Source 
then scroll the knob to select source. Once desired source selected, push the knob to exit the 
adjustment mode.

Press the BACK button to get back to the main menu. 
Try your hand at making some adjustments to help you get more familiar with the front 

panel controls.

The main menu of the BLADE 3 shows all of the options available from the front panel. 
These options are:

•	 Headphone...	–	Selects the headphone source and sets the gain.
•	 Delay...	–	Delay Control screen display delays in samples and 

seconds for each source.
•	 Input	Gain...	–	Displays the gain levels for selected inputs 

and allows the user to set the gain level for each input.
•	 Output	Gain...	–	Displays the gain levels for selected outputs 

and allows the user to set the gain level for each output.
•	 PLL	Mode...	–	Selects mode as Local or Remote.
•	 Meter	Mode... –	Sets the front panel meter mode for EDGE 

to show input or output signal levels.
•	 Network... – Shows the current IP Address, Net Mask, and Gateway 

 assigned to the EDGE. These settings can also be edited from this submenu. 
The EDGE is going to work in conjunction with WheatNet‑IP system. The EDGE 
must have its IP address, Net Mask, and Gateway settings configured according to 
the rules of the system it is joining. Since all devices in WheatNet-IP system must 
be on the same subnet, you will need to configure the EDGE to be compatible with 
the existing system.

•	 Host	Blade... – Allows you to display or change the Host Blade that the EDGE 
communicates with – setting is for the Host Blade IP address.

•	 Version... – Displays the current version of software running on the EDGE. If you 
need to call  Wheatstone  Technical Support with EDGE questions you may be asked 
to provide this  information.

To exit menu press the BACK button once if you are in menu screen or twice if you in 
submenu screen. 

See the Front Panel Menu Diagram on the next page.                               
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    Front Panel Menu Diagram
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EDGE GUI
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EDGE GUI

Installation and Overview
The EDGE comes with the Wheatnet Edge Setup Graphical User  Interface (GUI) 

program, intended to be straightforward in setup connection between the EDGE and the 
WheatNet‑IP system. On a user‑supplied computer  connected through an  Ethernet switch to 
the EDGE install the GUI by  running the installer file  wheatnetip_ edge_GuiSetup_X_X_X.
exe (where X_X_X indicates the program version number). The installer creates a  program 
with a file name of  WheatnetEdgeGui.exe. Double-click the icon for this file, or its short‑
cut, to run the GUI.

The EDGE GUI features a tabbed navigation architecture to easily access features 
with a minimum number of mouse clicks. 

The EDGE GUI screen is vertically divided into two parts with a Device  Properties 
Pane on the left side and a System Info Pane on the right side. Contents of the both Panes 
are change according to the tab selected. You may access any tabs of these Panes by 
simply clicking on them. 

At the bottom of the screen is a Devices Pane that displays a list of EDGE devices 
that the GUI has been configured to communicate with. Click Add... to add a device to 
the list, Edit... to change the name of an EDGE or give the GUI a different IP address to 
talk to it on, or Remove to delete the device currently highlighted in the list. To the right 
of these buttons is the Online check box, which is used to toggle the GUI connection to 
the highlighted device between online (checked) and offline (not checked).
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 Both of the System Info and Devices Panes are relocatable within the GUI window 
by clicking on the Pane’s button and dragging the Pane to the new location. You can even 
drag one or both of these Panes outside of the GUI window, a handy feature if you have 
two monitors. To bring a Pane back into the GUI, double‑click its title bar. 

Adding EDGE To The Devices Panel
We need to add the EDGE as a device before we can work with Wheatnet Edge Setup 

GUI. Click the Add... button along the bottom of the Devices panel to bring up the Add 
Device dialog:

Give the device a convenient Name: (note that the 
 system doesn’t care what name you use; it will display 
it for you so you can recognize the device, but it will 
not otherwise make use of the name). Click on the 
down arrow at the right end of the Device Type: field 
and  select Edge. Then fill in the IP Address: field with 
the IP address of the EDGE you are adding. Your Add 
Device dialog should look something like this:

 Click Ok. The device now shows up on the Devices panel.
Click once on the device in the Devices panel list to highlight it. Make sure the Online 

check box has an X in it (click it once if it is empty), and then observe the lower right 
corner of the program window. If all is well and the EDGE and the computer running 
the Wheatnet Edge Setup GUI are both on the same network, you should see a message 
 indicating you are connected to the EDGE.
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System Info Pane
Let’s turn our attention now to the System Info 

pane. The first time you start up the Wheatnet Edge 
Setup GUI this area will be blank. So let’s get it 
to fill in.

Select WheatNet-IP System>System Scan... 
from the Wheatnet Edge Setup GUI menu to see 
this dialog:

Start by specifying the Host Blade IP Address. 
This can be the IP address of any physical BLADE 
in the system. The Wheatnet Edge Setup GUI will 
query the chosen BLADE to get a map of the system 
resources. DO NOT use an EDGE IP Address for 
this operation; it will not provide the needed results. 
Once the BLADE IP address is entered, click Start 
Scan. The data area will start to fill in and after a 
period of time will indicate the scan is done.

When the scan is complete you will see a screen 
like this (the exact text is system‑dependent):

Click the Finish button. You will be asked 
if you want to save the system information 
just gathered.

It is a good idea to save this information at 
some point in time. Otherwise, every time you 
start the Wheatnet Edge Setup GUI you’ll need 
to do a scan to discover the available resources. 
On the flip side, any time you make a configura‑
tion change, you will need to do a fresh scan, 
and a save, to keep the program’s knowledge 
of the system in sync with the changes. If you 
choose to save at this time, click Yes. You’ll be 
prompted to add an (optional) comment to the 

file, after which you’ll be presented with the usual Windows file save dialog. Once the save 
is done you’ll be able to continue. If you won’t be saving right now, click No to continue.
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You will notice that the System Info now has content. Here is an example of what you 
might see on the Sources, Destinations, Salvos, and Blades tabs:

It is important to note that Blade Picker function will use the last scan information you 
saved. If you have changed configuration in regard to Blades present since last saving the 
scan information you should rescan and resave.
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Device Properties Pane

Blades Tab
In this section you will select the Host 

Blade that the EDGE communicates with.
Click the button with the three dots 

(ellipsis) to the right of the Host Blade 
field to bring up the Blade Picker dialog.

NOTE: If you have not done the system 
scan the Blade Picker dialog will not have 
any BLADE to show you. Also, if your 
system changed since the last scan and 
save the list available to the Blade Picker 
dialog may be incorrect.

Find the desired BLADE in the Blade 
Picker and double‑click on it to select. 

Miscellaneous Tab

3rd Party Signal Name Prefix

The EDGE has a four‑character device name. The default 
name is EDGE. The EDGE uses the WheatNet‑IP 3rd Party 
interface to define signals for handling  audio between the 
EDGE and the WheatNet‑IP system. The names of these 
signals use the four-character device name as the first four 
characters and then an appropriate  description as the last 
 characters. Changing the device name  allows customization 
of the signal names that can make it easier to identify the 
signals in Navigator.

Note: When you change the device name, it is  necessary 
to do the following. First, remove the 3rd Party  device 
definition for the particular EDGE from Navigator.   
Second, reboot the EDGE. And third, add the 3rd Party 
device definition back into Navigator.

Note: In most places, the 3rd Party device name is 
displayed next to the signal name and can also be used to 
help distinguish signals when multiple EDGEs are in use.
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PLL

The EDGE and BLADEs both use ethernet packets for 
sample rate clock synchronization. The IP radio inherently 
adds a substantial jitter to these timing reference packets.   
In order to overcome the jitter,  the error integration interval 
and overall loop locking must be extended significantly. 
A PLL MODE selection is provided to accommodate for 
this. In the Studio located EDGE case, the PLL MODE is 
set for  local since the jitter only is occurring at the far end 
of the IP radio link. The BLADE at the far end will need 
to be set to SLOW  PLL mode for that unit only. In the 
Transmitter located EDGE case, the EDGE PLL MODE is 
set to REMOTE.

The check box allows you to switch between the PLL 
modes:

• When the check box is unchecked the PLL Local text 
displays next to check box.

• When the check box is checked the PLL Remote text 
displays next to check box.

Display Brightness

The brightness of the displays can be controlled globally 
by the settings in this region. The displays brightness varies from a setting of 1 (which is 
off) to a maximum of 16. The displays also have a screen-saver mode. After a specified 
time, the display brightness will be automatically dimmed to an alternate brightness setting. 
When a button is pressed or an encoder is turned, the brightness returns to the normal level.

• Normal Level – This control specifies the normal brightness level of the display. 
The possible values vary from a low of 1 (off) to a high of 16.

• AutoDim Level – This control specifies the brightness level to be used when the 
displays are in screen‑saver mode. The possible values vary from a low of 1 (off) 
to a high of 16.

• AutoDim Timeout – This control specifies how long (in minutes) to wait before 
display is automatically dimmed. The allowed values range from 20 to 59 minutes. 

• Screen Saver Timeout – This control specifies how long (in minutes) to wait before 
entering screen‑saver mode. The allowed values range from 0 to 45 minutes.

Receive Sequence Errors 
The EDGE is monitoring the RTP sequence number field of the stream and  incrementing 

counters for each stream when a sequence error is detected. When the IP radio is  dropping 
packets these counters will respectively increment. These counters may assist in  qualifying 
the IP radio settings and quality of RF link. Error rates of less than 10 increments per hour 
are probably satisfactory.
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Visibilities Tab

Visibilities – Use the  Visibility  option 
setting to limit the sources the user 
sees when dialing up a source on the 
EDGE. This feature is helpful, espe‑
cially in large systems with lots of 
signals. NOTE: If you have not done 
the system scan you will not see all the 
sources that are available to the EDGE.

Scroll up and down the Channel list, 
check or uncheck signals as desired 
for that channel, and click the Apply 
button to save the visibility options. 
If you have made changes and then 
decided you don’t want to put the 
changes into effect, click Cancel. This 
will cancel any changes you made since 
entering the screen or since clicking  
Apply, whichever happened most re‑
cently.

Check the Global Alpha Sort box 
to sort the list of channels in alphanu‑
meric order when selecting sources on 
the EDGE.  

Check Allow No Source if you want NoSource to be allowed for that channel. If  
No Source is not allowed then the channel must always have a source selected. 

Right‑clicking in the Channel area of the Visibilities tab pops up a menu with some 
useful shortcuts on it:

• Copy – Choose this item to copy the visibility set‑
tings of the currently selected channel.

• Paste – Choose this item to paste visibility settings 
that have been copied from one channel to the cur‑
rently selected channel.

• Paste All – Choose this item to paste visibilities that 
have been copied from one channel to all channels.

• All – Choose this item to select all signals in the 
system to be visible to the currently selected chan‑
nel. This also puts a check in the Allow No Source check box.

• None – Choose this item to deselect all signals for the currently selected channel.  
This also removes the check, if present, in the Allow No Source check box.
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Delay Control Tab

The delay control allows for setting the 
buffer delay in audio samples. Typically the 
minimum delay might be 200 to 400 samples, 
i.e. something comparable to the half duplex pe‑
riod of the IP radio. Since this isn’t  necessarily 
a published spec of the radio, the method 
to set this would be to lower the delay until 
 audio dropouts can be heard, and then backing 
away from this setting. The maximum delay 
of upwards of one second is provided for just 
confirming that the correct connections have 
been set up and it is then obvious with the large 
delay.  Note that changing the delay setting does 
not immediately change the buffering delay.  
The buffer must first go empty in order to reset 
and then refill to new delay setting. This can 
be done by simply breaking and re‑making the 
connection in Navigator.

Stream Meters Tab

Displays meters of the streaming audio. 
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Inputs and Outputs Tabs
Both Input and Output section have  

meters and controls that used to monitor 
the level and set gain and balance of the 
stereo EDGE’s inputs/outputs signals.

The four pair baragraph meters show 
audio levels for the stereo channels color 
coded over a 40dB range, with the highest 
level being “+20” VU, corresponding to 
+24dBu, 0dBFS, and the onset of clip‑
ping. These meters show the actual signal 
level as modified by the gain setting. The 
bouncing bar at the top shows the peak 
audio level while the solid column shows 
the short term average audio level using 
VU time constants.

A slider control is for adjusting each 
channel’s gain or loss over a range of 
+/‑18dB. The slider handle moves to 
indicate a relative gain setting as you 
drag it with your mouse, and the text box 
below the slider updates with the specific 
gain value. If you prefer, you can drag 
your cursor over the number in the text 
box to highlight it and type in the gain 
value you want. The gain adjustment is made in real time and will reflect instantly on the 
bargraph meters. The system rounds off gain settings to the nearest 1/10th dB.

A balance control allows you to adjust the balance of the left and right stereo signal. 
The adjustments can be made by left clicking and holding the control while moving the 
cursor in a circular motion. If you prefer, the arrow keys can also be used to make this 
adjustment. Like the level control, you can highlight the number in the text box and set 
the balance level with “0” being center. The balance adjustments are also made in real 
time and will reflect instantly on the bargraph meters.

Please note that any gain modifications you make to a signal will affect the level of 
that signal everywhere in the system it appears.
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EDGE GUI Menu

File

The File menu contains items for setting a  password 
and for exiting the program:

•	 Set Password... – Used to set a password that will 
need to be entered to operate the Wheatnet Edge 
Setup GUI – when first installed the GUI requires 
no password – to set a password you must enter the 
current password and then enter the new password 
twice (the second to confirm the password).

•	 Exit – Used to exit the EDGE GUI.

View

The View menu is used to show or hide certain sections 
of the Wheatnet Edge Setup GUI or to change the GUI 
appearance:

•	 Devices – Used to show or hide the  Devices section.
•	 System Info – Used to show or hide the System 

Info section.
•	 Stylized – Used to toggle the Wheatnet Edge Setup 

GUI between a modern appearance and a more 
traditional one.

WheatNet-IP System

The WheatNet-IP System menu is used to  manage signal 
sets within the EDGE GUI:

•	 File Open... – Used  to open a saved signal set.
•	 File Save... – Used to save the current signal set.
•	 System Scan... – Used to scan the system to which 

the Wheatnet Edge Setup GUI is connected to get a 
list of all signals currently available in the system 
– this set can then be saved using File Save... and 
then later recalled using File Open... even if the 
EDGE is not connected to the system at that time.
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When you first start the Wheatnet Edge Setup GUI there will be no information show‑
ing in the  System Info section. Assuming that you are connected to a working system, you 
can get this  section to fill by selecting WheatNet-IP System>System Scan... from the GUI 
menu. This will display the WheatNet-IP System Scan screen:
System Scan was described in details earlier in 
the System Into Pane section on page 2‑5.

Hardware

The Hardware menu is used to set up 
devices in respect to connecting to them 
and managing their configuration and 
software:

•	 Add New Device... – Used to set 
up a new EDGE for the GUI to 
communicate with – brings up a 
dialog box to set a name, device 
type, and IP address:
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•	 Edit “ej229”... – Used to change the setup parameters 
for the highlighted EDGE using a similar dialog box:

•	 Remove “ej229”... – Used to delete the highlighted 
EDGE from the list after confirming the delete:

•	 Version... – Used to check the current version of software 
of the currently connected EDGE – this information may 
be needed in the event that Wheatstone Technical Support 
needs to be contacted about your unit.

•	 Update... – Used to change the software version of the 
currently connected EDGE.

•	 Reboot... – Used to reboot the currently connected EDGE 
– this is used primarily after doing a software update – a 
confirm dialog allows you to change your mind.

Help 

The Help menu gives additional informa‑
tion about the Wheatnet Edge Setup GUI:

•	 About... – Used to show the version 
of the Wheatnet Edge Setup GUI.

                             


